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Revision History

Product Version

Details of product version and the individual components of Application Designer Suite can be seen 

in the About ControlCare dialog:

Start=>Programs=>Endress+Hauser=>ControlCare=>Tools=>About ControlCare

Registered Trademarks

PROFIBUS® 

Registered trademark of the PROFIBUS User Organisation, Karlsruhe Germany. 

FOUNDATIONTM Fieldbus

Trademark of the Fieldbus Foundation, Austin, TX 78759, USA

HART® 

Registered trademark of the HART Communication Foundation, Houston, USA

Microsoft®, Windows®, Windows 2000® ,Windows XP®, Windows 2003 Server®, Windows 

2008 Server®,Windows 7®, Windows Vista® and the Microsoft logo are registered trademarks of 

the Microsoft Corporation.

Acrobat Reader® is a registered trade mark of the Adobe Systems Incorporated.

All other brand and product names are trademarks or registered trademarks of the companies and 

organisations in question

Product 

version

Manual Changes Remarks

2.00.xx BA035S/04/en/01.05 Original manual Split from previous manual BA021S/04/en of 07.02

2.01.xx BA035S/04/en/08.05 Setup Setup modified, Update added, OpenOCS added

Editorial Descriptions of function blocks descriptions improved

2.01.xx BA035S/04/en/03.06 Setup OpenPCS Service Pack 1: No effect on operation

2.02.xx BA035S/04/en/07.06 Setup Chapter 2: Setup changed to install all components

Editorial • Simulation for Local I/O added (Chapter 7.1)

• Pulse Input block description revised (Chap. 5.3.5)

2.03.xx BA035S/04/en/06.07 Setup • Update and deinstallation improved

Program • New preferences dialog (packing)

• Assign All Tags added

Going on-line • New HSE Network Tools program

• New Field Controller Web Server program

Trouble-Shooting • New FC Tools program and firmware download

• New Exchange procedure

2.04.xx BA035S/04/en/12.08 System requirements • Windows Vista now supported

Aliasing, 

Embedded hybrid FB

• Aliasing added to Preferences, Chapter 3.3

• Aliasing added to HC configuration, Chapter 5.2.1

• Note Hybrid FB added to Channel, Chapter 5.3.1

2.05.xx BA035S/04/en/06.10 General • Version, documentation table, windows support

Getting Started • Screenshots updated

Trouble-Shooting • FRC LED description updated for battery power
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1 Safety

1.1 Designated use

ControlCare is a field-based control system comprising hardware and software modules. It can be 

used to visualize, monitor and control production processes. The hardware described in this manual 

allows a modular FOUNDATION Fieldbus or PROFIBUS controller to be built. It comprises a 

number of separate units that may include power supply modules, power conditioning modules, 

fieldbus linking devices, controllers, interfaces, analog I/O and discrete I/O units. The approved 

usage of the individual units used in the system can be taken from the corresponding parts of these 

operating instructions.

1.2 Installation, commissioning and operation 

ControlCare Field Controller modules have been designed to operate safely in accordance with 

current technical safety and EU directives. Essential to their use is the ControlCare Application 

Designer software, which allows control strategies to be created for both FOUNDATION Fieldbus 

and PROFIBUS applications. Field devices, links, junction boxes, cables and other hardware 

comprising the Fieldbus sytem must also be designed to operate safely in accordance with current 

technical safety and EU directives. 

If devices are installed incorrectly or used for applications for which they are not intended, or if the 

controller is not configured correctly, it is possible that dangers may arise. For this reason, the system 

must be installed, connected, configured, operated and maintained according to the instructions in 

this and the associated manuals: personnel must be authorised and suitably qualified.

1.3 Operational safety

Location Field Controllers must be mounted in a permanent and weather-protected location in a safe area. 

The environment shall be a metal cabinet or an installation frame with a well grounded mounting 

plane. The environment shall be protected. 

Hazardous areas The controller must be connected to networks operating in explosion hazardous areas via barriers 

or other safety components. When installing components in explosion hazardous areas:

•  Ensure that all installion and maintenance personnel are suitably qualified

•  Check that all equipment has the appropriate safety certificates

•  Observe the specifications in the device certificates as well as national and local regulations.

This topic is discussed in BA013S (FF Guidelines) and BA034S (PROFIBUS Guidelines).

EMC All modules are suitable for industrial use and conform with the following standard, see Appendix:

•  EN 61326: 1997/A1: 1998

Interference emmision: Class A apparatus

Interference immunity: as per Annex A, industrial environment

Depending upon the environment in which the bus is operating, particular attention should be paid 

to the grounding of the bus cables. This topic is discussed in BA013S (FF Guidelines) and BA034S 

(PROFIBUS Guidelines).
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IP Address Field Controller is normally configured from a workstation connected into the control system 

backbone. You will require a unique IP address to set it up.

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

It is recommended that ControlCare Field Controllers and OPC servers are not installed in an office 

network, as the large data packets exchanged between office equipment may lead to timeouts and 

intermittent communication errors. Ideally, the ControlCare system network should operate within 

its own IP domain; if this is not possible it should be separated from other parts of the network by 

a managed switch.

Since the system can be accessed and manipulated through the various Field Contoller tools, it is 

advisable to control access both to the workstation and the folders in which the configuration is 

stored. Always make a back-up of the project.

Technical improvement Endress+Hauser reserves the right to make technical improvements to its software and equipment 

at any time and without prior notification. Where such improvements have no effect on the 

operation of the equipment, they are not documentated. If the improvements effect operation, a 

new version of the operating instructions is normally issued. 

1.4 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions Icon Meaning

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation or 

may lead to an instrument response which is not planned

Caution!

Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or 

incorrect functioning of the instrument

Warning!

A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, a 

safety hazard or destruction of the instrument
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1.5 ControlCare documents

Table 1.1 indicates the documents, planned and realized, containing safety relevant information, 

installation, commissioning and operating instructions for the equipment and software associated 

with Field Controller.

All documentation available at the time of release is included on the ControlCare CD-ROM and is 

installed in Start=>Programs=>Endress+Hauser=ControlCare=Manuals during set-up.

Tab. 1-1: ControlCare Documentation

Component Description Document type Designation Order No.

System ControlCare System Overview Operating manual BA016S/04/en 56004883

ControlCare System Design Operating manual BA039S/04/en Planned

ControlCare System Specifications Operating manual BA040S/04/en 56004888

Software Application Designer Overview Operating manual BA017S/04/en 70104301

Application Designer: Local I/O Tutorial Operating manual BA032S/04/en 71095009

Application Designer: FF Tutorial Operating manual BA019S/04/en 70101151

Application Designer: PROFIBUS Tutorial Operating manual BA036S/04/en 70101152

Application Designer: MODBUS Tutorial Operating manual BA037S/04/en 70101153

Application Designer: IEC 61131-3 

Ladder Logic Tutorial 

Operating manual BA038S/04/en 70101386

Application Designer: IEC 61131-3

Structured Text Tutorial

Operating manual BA056S/04/en 71060063

Field Control (OPC) Servers Operating manual BA018S/04/en 71031428

SFC162 Visitor Operation manual BA069S/04/en 71113457

Field Controller Hardware Installation Guide Operating manual BA021S/04/en 56004885

Commissioning and Configuration Operating manual BA035S/04/en 56004887

Function Blocks Function Block Manual Operating manual BA022S/04/en 56004886

Set-Up Getting Started Operating manual BA020S/04/en 56004884

General FOUNDATION Fieldbus Guidelines Operating manual BA013S/04/en 70100707

PROFIBUS Guidelines Operating manual BA034S/04/en 56004242



2 Getting Started ControlCare Field Controller: Commissioning and Configuration

6 Endress+Hauser

2 Getting Started

ControlCare Application Designer Suite runs on the operating systems Windows 2000, Windows 

XP, Windows Server 2003 and Windows Vista with the service packs indicated in the System 

Requirements:

•  You need to have administrator rights for the installation of the ControlCare Application 

Designer Suite. 

•  Application Designer Suite operates with a license protection key. Any licence keys already 

used on your computer should be unplugged before the software is installed.

•  You will be warned, if the system requirements are not met.

•  Windows Firewall may want to block some features of the program: if the dialog box appears 

during setup, click Unblock to ensure correct function.

2.1 Preliminaries

1 Place the ControlCare CD-ROM in your CD-ROM drive, the Setup menu appears just after the 

CD has been inserted.

2 First check that your computer fulfils the minimum System Requirements as described 

below

.

3 Before starting the installation it is advisable to carefully read the Release Notes.
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2.2 Installing Application Designer Suite

1 Click on ControlCare Field-based Control System to initiate the software installation 

process.

2 The setup program starts the installation process:

If a ControlCare version <02.02.xx is found on your computer, you will be asked to deinstall it.

– Press OK to close the warning dialog window 

– Open the Windows Control Panel and uninstall Application Designer and if appropriate 

OpenPCS using the Add/Remove function

– Restart the setup program - see Step 1

If a ControlCare version greater or equal to 02.02.xx is found on your computer, 

a modified Welcome dialog appears

– Continue the installation by clicking Next

– The installation continues as described in Chapter 2.4, Upgrades.

3 If ControlCare was not installed previously the Welcome dialog appears

– Continue the installation by clicking Next
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4 The Licence Agreement now appears

– Read the agreement, then check the button saying that you agree with it

– Print will cause a copy of the license agreement to be printed out

– Continue the installation by clicking Next

5 The Components dialog appears

– Press Next to accept the default settings

6 The Choose Destination Location dialog appears

– Press Change and follow the instructions if you want to select a different destination.

– Press Next to accept the default destination and/or to continue installation.
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7 The Start Copying Files dialog appears

– Read the list the applications to be installed

– If you want to change anything, press Back until you reach the appropriate screen

– Continue the installation by pressing Install

8 ControlCare Application Designer Suite will now be installed

– You are informed of progress through the Setup Status dialog

– Answer Yes should you be prompted to delete a previous version of OpenPCS

9 The Installation Complete dialog appears after everything was installed

– Press Finish to complete the procedure and close the dialog

– After computer restart, plug the hard key into the USB or parallel port of your computer
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2.3 Installing the OPC Servers only

The sequence is essentially the same as that described in Chapter 2.2.

1 Click on ControlCare Field-based Control System to initiate the software installation process.

2 The Welcome dialog appears, continue the installation by clicking Next

3 The Licence Agreement now appears. 

– Read the agreement, then check the button saying that you agree with it

– Continue the installation by clicking Next

4 The Components dialog appears 

– Deselect both the Application Designer and OpenPCS boxes

– The remaining components are those needed for the OPC server

– Press Next to continue with the installation

5 Follow the wizard instructions to complete the installation, see Chapter 1.2, Steps 6 to 9.



ControlCare Field Controller: Commissioning and Configuration 2 Getting Started

Endress+Hauser 11

2.4 Upgrades

Only ControlCare Versions greater than or equal to 2.02.xx can be upgraded.

1 Click on ControlCare Field-based Control System to initiate the software installation process.

2 IThe setup program detects the earlier version of Application Designer Suite

– The Welcome to update page appears

– To continue click on Next 

3 In the Components dialog press Next to accept the default settings

– Alternatively select the components you wish to update and press Next.

4 When the Maintenance Complete dialog appears, press Finish to finish the procedure and 

close the dialog. 
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2.5 Additional Tools

2.5.1 Adobe Reader

All current manuals related to ControlCare hardware and software products and other auxiliary 

information manuals are copied to your computer during installation. You require Adobe Reader 

Version 5.0 or higher to read them. If not already on your computer, you can install the latest 

version as described below.

1 Go to the main menu on the ControlCare CD-ROM and select Adobe Reader

2 Now choose the language version and follow the instructions in the Installation Wizard.

3 To open a manual from your computer select 

Start=>Programs=>Endress+Hauser=>ControlCare=>Manuals=>English

From the Setup menu

– Getting Started opens a PDF version of the Getting Started manual

– Open Documentation opens the folder containing the manuals.

2.5.2 OPC Data Spy

OPC Data Spy is a simple OPC client tool that is installed with ControlCare Application Designer 

Suite. It allows the values output by devices in a fieldbus network to viewed and monitored.

1 Open OPC Data Spy

– Start=>Programs =>Endress+Hauser=>ControlCare=>Tools=>OPC Data Spy

2 Instructions on use are to be found in the online help.
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2.6 Checking Your Installation

2.6.1 License

You can check your license to see the number of Tags and Function Blocks that are supported. This 

information is also required should you want to request a Tags license upgrade.

1 Open Check Licence: 

– Start=>Programs =>Endress+Hauser=>ControlCare=>Tools=>Check License

2 In the example, it can be seen that there are two licenses in the hard key (dongle): 

– Field Control HSE OPC Server supports an unlimited number of tags

– Field Control IEC OPC Server supports an unlimited number of tags

– ControlCare Application Designer supports 4096 Function Blocks. 

2.6.2 Application versions

It is sometimes necessary to check all product related version information, for example, when you 

are looking for product support or a product update. 

1 Open About ControlCare: 

– Start=>Programs =>Endress+Hauser=>ControlCare=>Tools=>About ControlCare

2 A dialog box now appears containing all version information for ControlCare software 

components.

– It can be copied onto the clipboard by selecting the text within the box by scrolling the 

mouse over it. 

– Now press the sequence "Crtl+Insert" to copy it and "Shift+Insert" to paste it into another 

text document.

– The information contained may differ from the screenshot above which was made before the 

final build of the currrent version
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2.7 Deinstalling ControlCare Application Designer Suite

Once ControlCare Application Designer Suite has been installed, it can be deinstalled if required via 

the Windows Control Panel. 

1 Select Start=>Settings=>ControlPanel then click on Add or Remove Programs

2 Select ControlCare Field-based Control System and then Remove

3 You will be asked to confirm the removal of particular software components. Confirm that you 

want to remove them with Yes

4 Windows proceeds with the de-installation

– Pressing “Cancel“ aborts the de-installation process.

Note! 

• In the event that field devices were already integrated in ControlCare Application Designer, the 

associated files (DDs & CFF) will not be deleted. Similarly if configuration files for projects have 

been created, they will not be removed, The files can be found in the location they had before 

ControlCare was deinstalled.
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3 FF Field Controller

The Field Controller is configured with the ControlCare Application Designer software. Before you 

use this for the first time, check that the your hard key (dongle) is connected to your computer (This 

is not necessary if you have a demo license or intend to use it as a demo version only). 

3.1 Open ControlCare Application Designer

1 Start Application Designer:

Start=>Programs =>Endress+Hauser=>ControlCare Application Designer

– The welcome screen appears

– If projects already exist, the last one use will be automatically loaded at this stage.

2 The first time you use the program, the workspace remains blank

– If projects already exist, the last one used will be loaded as default

– The default settings of the workspace management can be changed by selecting 

Project File => Preferences => Workspace Layout
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3.2 Create a FF project

1 The project starts from a blank application screen

– With the right mouse key select Project File=>New

1 The Document Type box appears: Click the option Project

2 The Setup New Project Workspace dialog box opens:

– Choose the folder where the project will be saved.

– Type the name of the project in the File Name field.

– Click Save.

If the new project is not to be created, click Cancel.

3 ControlCare Application Designer automatically creates a folder with the entered file name 

within the selected folder.
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3.3 Determine the naming preferences

Before you start, you can set preferences for the way your project is created. Of particular interest 

at this stage is the labelling of the function blocks.

1 Press Project File => Preferences

– The Preferences Dialog appears

Tag Policy Tag Policy determines how the blocks are labelled by default if no tag names are entered

1 Select the folder Block and the subfolder Tag Policy, then check the following buttons

– Device

– Update Block Tag

2 Press OK to confirm your selection

– Application Designer will now automatically rename any blocks created in the control

strategy window as they are assigned to the devices by adding the device tag as prefix.

Tag Composition Tag Composition determines how the block identifiers are added to the block tag if no block name 

is entered.

1 Select the subfolder Tag Composition:

– Enter a mnemonic separator: for this manual the setting was "-"

Default setting is "_" and mandatory if flexible function blocks are to be used

– Check Prefix

2 Press OK to confirm your selection

– Application Designer will now automatically compose the blocks according to your

selection, e.g. TagName-Block-n or TagName_Block_n.

Export Tag Export Tag causes tags to be automatically exported every time the project goes online

1 Select the subfolder Export Tag

– Check the Automatic button

– Press OK to confirm your selection

Strategy Strategy determines the default shape of the function block icons in the stratagy window and also 

whether the aliasing function is enabled

2 Select the subfolder Strategy

– Select the default shape for function block objects

– Select "Aliasing Input Dialog Box" if you want to use your own input and output labels 

in the strategy 

– Press OK to confirm your selection
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3.4 Add a bridge (SFC162)

1 On saving, ControlCare Application Designer automatically creates a project, adding the HSE 

fieldbus network and the HSE Host

– Click on + to expand the tree:

2 Now right-click on the HSE Network leaf and select New=>Bridge

3 The New Bridge dialog box appears:

Select the SFC162 Field Controller and type in a device TAG 

If you do not type in a tag, the default will be "Bridge n", where n is a consecutive number. At 

this point, the Fieldbus Network does not have a direct correspondence to any of the existing 

controllers.

4 Press OK to create the Bridge.

5 Repeat Steps 1 to 4 for as many bridges as you have in your network.
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3.5 Add a fieldbus segment

1 The project now looks like this:

2 Right click on the bridge you just created, here "Bridge 1", and select New Fieldbus.

3 The New Fieldbus dialog box appears:

– Enter a Fieldbus TAG

If you do not type in a tag, the default will be "Fieldbus n", where n is a consecutive number. 

– Enter the number of the fieldbus port of the SFC162

– Press OK to create the Fieldbus.

4 Open Project File, then press Save, to save the project.

5 Repeat Steps 1 to 5 for as many fieldbuses as are in use (max. 4 per bridge).

6 You can now proceed with Configuring the Field Controller, see Chapter 5.

– More information on creating FF projects is to be found in the FF Tutorial.
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4 PROFIBUS Field Controller

The Field Controller is configured with the ControlCare Application Designer software. Before you 

use this for the first time, check that the your hardkey (dongle) is connected to your computer (This 

is not necessary if you have a demo license or intend to use it as a demo version only). 

4.1 Open ControlCare Application Designer

1 Start Application Designer:

Start=>Programs =>Endress+Hauser=>ControlCare Application Designer

– The welcome screen appears

– If projects already exist, the last one use will be automatically loaded at this stage.

2 The first time you use the program, the workspace remains blank

– If projects already exist, the last one used will be loaded as default

– The default settings of the workspace management can be changed by selecting 

Project File => Preferences => Workspace Layout
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4.2 Create a PROFIBUS project

Note!

• If you have both a PROFIBUS and FOUNDATION Fieldbus controller in your network, and have 

already created a FF project, select it through Project File=>Open and turn to Chapter 4.3.

1 The project starts from a blank application screen

– With the right mouse key select Project File=>New

2 The Document Type box appears: Click the option Project

3 The Setup New Project Workspace dialog box opens:

– Choose the folder where the project will be saved.

– Type the name of the project in the File Name field.

– Click Save.

If the new project is not to be created, click Cancel.

4 ControlCare Application Designer automatically creates a folder with the entered file name 

within the selected folder.

5 At this point you can set the project preferences, see Chapter 3.3.
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4.3 Add a gateway (SFC173)

1 On saving, ControlCare Application Designer automatically creates a project, adding the HSE 

fieldbus network and the HSE Host

2 Now right-click on the HSE Network leaf and select New=>Gateway

3 The New Gateway dialog box appears:

Select the SFC173 Field Controller and type in a device TAG 

If you do not type in a tag, the default will be "Gateway n", where n is a consecutive number. 

At this point, the Fieldbus Network does not have a direct correspondence to any of the 

existing controllers.

4 Press OK to create the Gateway.

5 Repeat Steps 1 to 4 for as many gateways as you have in your network.
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4.4 Add a PROFIBUS segment

1 The project now looks like this:

2 Right click on the bridge you just created, here "Gateway 1", and select New Profibus.

3 The New Profibus dialog box appears:

– Enter a Profibus TAG

If you do not type in a tag, the default will be "Profibus n", where n is a consecutive number. 

– Press OK to create the Fieldbus.

4 The ControlCare PROFIBUS Configurator opens
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5 You can either create the segment now:

– See Application Designer PROFIBUS Tutorial, BA036S/04/en, 

or 

create it at a later date: 

– Resume configuration at any time by double-clicking on the leaf "Profibus n"

– In the PROFIBUS window that opens, right-click on "Profibus n" again

– Select Modify PROFIBUS Configuration

6 Select File=>Save to store the PROFIBUS project, then Exit to close the window

7 The PROFIBUS I/O Mapping dialog appears

– Select OK to close the dialog

8 The Profibus segment is now added to the project:

9 Open Project File, then press Save, to save the project.

10 Repeat Steps 1 to 10 for each gateway that you have created.

11 You can now proceed with Configuring the Field Controller, see Chapter 5.

– More information on creating PROFIBUS projects is to be found in the PROFIBUS Tutorial.
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5 Configuring the Field Controller

Note!

• The SFC162 and SFC173 Field Controllers are configured in exactly the same way

• The configuration of the local I/O in connection with the hybrid block with embedded I/O is 

described in more detail in the Application Designer Local I/O tutorial, BA032S/04/en

When the Field Controller is created, ControlCare Application Designer automatically adds the 

following function blocks to it, where n is a consecutive number and Device Tag your name for the 

Field Controller (Mnemonic separator set set to "-", see Chapter 3.3):

•  Resource Block: Device Tag-RS-n

•  Transducer Block: Device Tag-PBTRD-n for the SFC173 Field Controller

•  Hardware Configuration Block: Device Tag-HC-n

•  Diagnosis block: Device Tag-DIAG-n 

In addition a temperature transducer block must be manually added for every SFC445 Temperature 

Input module in use. 

5.1 Customise the Controller I/O blocks

Procedure 1 Start the configuration by clicking on the Fieldbus/Profibus branch in your project: A fieldbus 

window opens. Expand the Field Controller branch to display the various blocks:

2 If the Field Controller has one or more SFC445 Temperature Input modules, add a 

Temperature Transducer block (TEMP) for each module:

– Right click on the FBAP node and select New Block

– In the New Block dialog, select the Block Type Temperature Transducer

– If necessary, enter a new Device Tag (otherwise the block will be numbered consecutively)

– Press OK to create the block

– The new block is added to the Field Controller

– Repeat until there is a Temperature Transducer block for each SFC445 module.

3 When all required transducer blocks blocks are present, configure each as described in the 

following sections.
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5.1.1 Resource block

Procedure 1 Right click on the Field Controller resource block Device Tag-RS-n and select Off Line 

Characterization (or double click on the leaf). The Characterization dialog opens:

2 Expand the MODE_BLK node and check that the Target Mode is set to Auto

– If this is not the case, select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

5.1.2 Transducer block

Procedure 1 For the SFC173 Field Controller, right click on the transducer block Device Tag-PBTRD-n 

and select Off Line Characterization. The Characterization dialog opens.

2 Expand the MODE_BLK node and check that the Target Mode is set to Auto

– If this is not the case, select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

Detailed information on the other parameters in this block can be found in the Function Block 

manual BA022S/04/en.
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5.2 Configure the I/O transducer blocks

5.2.1 Hardware configuration block

This block configures the module type for each slot in the Field Controller rack. The physical 

arrangement of the modules on the rack assemblies with the addresses 0 to 14 is declared in the 

parameters IO_TYPE_R0 to IO_TYPE_R14 respectively. Each IO_TYPE_Rx parameter has four 

slot parameters, SLOT_0 to SLOT_3, where the module type is entered. (Addressing and slot 

numbers are explained in Chapters 3.5.3 and 3.5.4 of BA021S/04/en).

On execution, the Field Controller writes to all declared output modules and reads all declared input 

modules. If any I/O module has failed in this scan, it is indicated in BLOCK_ERR and the 

MODULE_STATUS_x parameters. 

Procedure 1 Right click on the Field Controller hardware configuration block Device Tag-HC-n and select 

Off Line Characterization. The Characterization dialog opens

2 Expand the MODE_BLK node and check that the Target Mode is set to Auto

– If this is not the case, select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 The slots in IO_TYPE_R0 are preset to "No I/O" when the bridge/gateway is created

– Do not change these settings, even when the rack address "0" is not used

– Do not configure I/O modules in the IO_TYPE_R0 parameter, it is not allowed

4 If the Field Controller is not at address "0" or you have local I/O in your rack, expand the 

appropriate IO-TYPE_Rx node add the module type to the slots

– Select the SLOT_No, then click the Edit button

– Select the module type from the drop-down menu: 

– Use "No I/O" for controllers, power supplies, conditioners etc

– Use "Available" for dummy modules or unused slots

– If the alias function is enabled, parameter names can be overwritten by double clicking

– Click on End Edit after each change

– Continue until all modules have been mapped to the correct positions in the rack.
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5 Now click on the Block Tag Assignment segment of the SLOT_0 node to open the 

correspondiing configuration menu:

– Select the function block to which the module is to be connected

see Chapter 5.3.3 to 5.3.7 for more details on block usage

– Repeat the procedure for all other occupied slots

6 Repeat Steps 4 and 5 for all rack assemblies in the rack

7 Click Close to end configuration and save the project. 

– The Device Tag-HC-n node will now have the configured parameters attached

– The connected function blocks will be automatically created with the correct 

channel number, see Chapter 5.3.1

– If the alias function is enabled, the Rename dialog can be called by right click

I/O types and blocks

Tab. 5-1: : I/O types and corresponding function blocks

Designation Description I/O type Function Block

Available slot No I/O None

SFC050 Power Supply 90-264 VAC No I/O None

SFC056 Power Supply for Backplane 20-30 VDC No I/O None

SFC162 FF Field Controller, 1x100 Mbps, 4xH1 No I/O RS/HC/DIAG

SFC173 PROFIBUS Field Controller, 1x100 Mbps, 4xH1 No I/O RS/HC/DIAG

SFC252 AC Power Supply for Fieldbus No I/O None

SFC260 DC Power Supply for Fieldbus No I/O None

SFC353 4-channel Power Supply Impedance No I/O None

SFC411 2 Groups of 8 24 VDC Inputs (Isolated) 16-discrete input MDI/DI

SFC415 2 Groups of 8 24 VDC Inputs  (Sink, Isolated) 16- discrete input MDI/DI

SFC420 1 Group of 8 On/Off Switches 8- discrete input MDI/DI

SFC428 2 Groups of 8 NO Relays Outputs 16- discrete output MDO/DO

SFC432 1 Group of 8 24 VDC Inputs and 

1 Group of 4 NO Relays

8- discrete input/

4- discrete output

MDI/DI

MDO/DO

SFC435 1 Group of 8 24 VDC Inputs and 

1 Group of 4 NC Relays

8- discrete input/

4- discrete output

MDI/DI

MDO/DO

SFC438 1 Group of 8 24 VDC Inputs and

1 Group of 2 NO and 2 NC Relays

8- discrete input/

4- discrete output

MDI/DI

MDO/DO

SFC441 2 Groups of 8 pulse inputs - low frequency 16-pulse input PUL

SFC442 2 Groups of 8 pulse inputs - high frequency 16-pulse input PUL

SFC444 1 Group of 8 analog inputs with shunt resistors 8-analog input MAI/AI

SFC445 1 Group of 8 temperature inputs 8-temperature MAI/AI

SFC446 1 Group of 4 analog output 4-analog output MAO/AO

SFC457 1 Group of 8 differential analog inputs with shunt 

resistors

8-analog input MAI/AI

SFC467 2 Groups of 8 pulse inputs - AC 16-pulse input PUL
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HC block parameters

Tab. 5-2:  Harware Configuration Block parameters

Parameter Valid 

range/

Options

Default 

value

Description/Action

ST_VER 0 Increments on every static parameter change

TAG_DESC blanks User specific text of 32-characters to uniquely identify the 

block

STRATEGY 0 to 255 0 User specific value that may be used in configuration and 

diagnositics as a key in sorting block information

ALERT_KEY 1 to 255 1 User specific value that may be used in sorting the alarms and 

events generated by the block

MODE_BLK TARGET O/S Set to AUTO

BLOCK_ERR 0 to 15 Error status of hardware and software components associated 

with the block

REMOTE_IO Set to Remote I/O master (MODBUS applications only)

IO_TYPE_R0 0 Module type for rack 0, slots 0 to 3

Preset to "Not I/O" - do not change

IO_TYPE_R1 0 Select module type for rack 1, slots 0 to 3

IO_TYPE_R2 0 Select module type for rack 2, slots 0 to 3

IO_TYPE_R3 0 Select module type for rack 3, slots 0 to 3

IO_TYPE_R4 0 Select module type for rack 4, slots 0 to 3

IO_TYPE_R5 0 Select module type for rack 5, slots 0 to 3

IO_TYPE_R6 0 Select module type for rack 6, slots 0 to 3

IO_TYPE_R7 0 Select module type for rack 7, slots 0 to 3

IO_TYPE_R8 0 Select module type for rack 8, slots 0 to 3

IO_TYPE_R9 0 Select module type for rack 9, slots 0 to 3

IO_TYPE_R10 0 Select module type for rack 10, slots 0 to 3

IO_TYPE_R11 0 Select module type for rack 11, slots 0 to 3

IO_TYPE_R12 0 Select module type for rack 12, slots 0 to 3

IO_TYPE_R13 0 Select module type for rack 13, slots 0 to 3

IO_TYPE_R14 0 Select module type for rack 14, slots 0 to 3

MODULE_STATUS_R0_3 Status of modules in rack 0-3

MODULE_STATUS_R4_7 Status of modules in rack 4-7

MODULE_STATUS_R8_11 Status of modules in rack 8-11

MODULE_STATUS_R12_14 Status of modules in rack 12-14

UPDATE_EVT This alert is generated by any change to the static data

BLOCK_ALM The block alarm is used for all configuration, hardware, 

connection failure or system problems in the block. The cause 

of the alert is entered in the subcode field. The first alert to 

become active will set the Active status in the Status attribute. 

As soon as the Unreported status is cleared by the alert 

reporting task, another block alert may be reported without 

clearing the Active status, if the subcode has changed.

HFB_STATUS_R0_3 Status of and hybrid function block connected to rack 0-3

HFB_STATUS_R4_7 Status of and hybrid function block connected to rack 4-7

HFB_STATUS_R8_11 Status of and hybrid function block connected to rack 8-11

HFB_STATUS_R12_14 Status of and hybrid function block connected to rack 12-14
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5.2.2 Temperature transducer block

A temperature transducer block is required for every SFC445 temperature module in the rack. The 

module has eight input channels for RTD, TC, mV or Ohm. The block mode, channel, sensor 

connection and sensor type at each input channel must be configured for each module.

1 Right click on the Field Controller hardware configuration block Device Tag-TEMP-n* and 

select Off Line Characterization. The Characterization dialog opens:

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the rack number and slot, where the SFC445 is installed

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value:

Rack+Slot+09, e.g. Rack 1, Slot 2, 09 = 1209 (see Chapter 5.3.1)

– Click on End Edit 

4 Configure the sensor connection and sensor type used at each input channel. 

– Select the SENSOR_TYPE_X, then click the Edit button

– Select the sensor type from the drop-down menu, click on End Edit

– Select the SENSOR_CONNECTION_X, then click the Edit button

– Select the connection type from the drop-down menu, click on End Edit 

– Continue until all input channels have been mapped correctly.

If the sensor connection is not on view, press the ALL button in the toolbar

(the parameters are under VALUE_RANGE_x in the reverse order)

5 Click Close to end configuration and save the project. 

The TEMP-X Device Tag node will now have the configured parameters attached
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Temperature Block 

parameters
Parameter Valid 

range/

Options

Default 

value

Description/Action

ST_VER 0 Increments on every static parameter change

TAG_DESC blanks User specific text of 32-characters to uniquely identify the 

block

STRATEGY 0 to 255 0 User specific value that may be used in configuration and 

diagnositics as a key in sorting block information

ALERT_KEY 1 to 255 1 User specific value that may be used in sorting the alarms and 

events generated by the block

*MODE_BLK TARGET O/S Set to AUTO

BLOCK_ERR 0 to 15 Error status of hardware and software components associated 

with the block

*CHANNEL. 0 The rack and slot number of the associated SFC445 module 

coded as per Chapter 5.3.1, whereby G = 0 and P = 9 (whole)

TEMP_0...TEMP_7 The temperature value and status at input point 0...7

VALUE_RANGE_0....

VALUE_RANGE_7

0-100% When the point is connected to an AI block, this is a copy of 

XD_SCALE. 

*SENSOR_CONNECTION_0.

..

SENSOR_CONNECTION_7

1, 2, 3 1 Type of sensor connection for points 0...7

1 = differential, 2 = 2-wire, 3 = 3-wire

*SENSOR_TYPE_0

...

SENSOR_TYPE_7

menu Pt100 The type of sensor connected to points 0...7

(Select from pull-down menu)

UPDATE_EVT This alert is generated by any change to the static data

BLOCK_ALM The block alarm is used for all configuration, hardware, 

connection failure or system problems in the block. The cause 

of the alert is entered in the subcode field. The first alert to 

become active will set the Active status in the Status attribute. 

As soon as the Unreported status is cleared by the alert 

reporting task, another block alert may be reported without 

clearing the Active status, if the subcode has changed.

*Parameters must be configured for every input used, every SFC445 module requires a separate Temperature 

Block
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5.3 Add and configure the I/O function blocks

Once the Hardware Configuration and Temperature transducer blocks have been configured, they 

must be connected to input and output function blocks so that the I/O signals are available to the 

Field Controller system.

Note!

• BA 022S/04/en, Function Block Manual, contains a general description of the function block 

process, including the alarming and I/O options that have been omitted for simplicity here. It also 

contains a detailed explanation of all function block parameters.

5.3.1 CHANNEL parameter

Note!

• If the multiple embedded hybrid I/O block is used to integrate the local I/O modules, the channel 

parameter is not required. Instead a special tool, called by clicking on the block leaf, guides the 

user through the configuration, see the Local I/O tutorial, BA032S/04/en. 

The connecting element between transducer and function block is the channel parameter. For the 

Field Controller I/O modules, this is compiled according to the following hierarchy: 

The value in the CHANNEL parameter is given by the value RSGP:

•  Rack assembly address (R): 

Each rack assembly has a unique address between 0 an 14 . 

The rack assembly with the address "0" cannot be used by the I/O modules.

•  Slot  (S): Each rack assembly has four slots. One slot supports one I/O module.

Slots are numbered from 0 (first slot) to 3 (last slot).

•  Group (G): Ordinal number of group in the specified I/O module

Groups are numbered from 0 (first group) to number of groups minus 1.

•  Point (P): Ordinal number of I/O point in a group

I/O points are numbered from 0 (first I/O point) to 7 (last I/O point in the group)

9 means the whole group of points and is used when a module is connected to a MAI, MDI, 

MAO or MDO function block.

Thus, a single I/O point in the Field Controller may be identified by specifying the rack (R), slot (S), 

group (G) and point (P). As the CHANNEL parameter in the multiple I/O blocks (MIO) must specify 

the whole group (8 points), the point must be 9, meaning the whole group. For example:

•  The CHANNEL parameter 1203 means rack 1, slot 2, group 0 and I/O point 3. 

•  The CHANNEL parameter for a MAI block 10119 means rack 10, slot 1, group 1 and

I/O point 9, i.e. the whole group. 

Provided that the HC transducer block is configured before the CHANNEL parameter, the system 

verifies that the I/O type configured in the HC block is suitable for block type. If the CHANNEL 

parameter of the AI block accesses an I/O of a different type, the setting will be rejected during 

download. In this case the channel is set to "0" and a corresponding error is set in the BLOCK_ERR 

parameter, which can be viewed online.

Level Range 

Rack (R) 0 – 14

Slot (S) 0 – 3

Group (G) 0 – 1

I/O Point (P) 0 – 7

9 = whole group
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5.3.2 Create input/output function blocks

For each I/O module configured in the HC transducer block, create the Input or Output Function 

Block associated with it, see Table 4-1, Chapter 4.7.1:

– AI – Analog Input: for individual inputs requiring signal characterisation

– DI – Discrete Input: for individual inputs requiring signal characterisation

– PUL – Pulse Input: for pulse inputs

– MAI – Multiple Analog Input: for complete groups of analog points

– MDI – Multiple Discrete Input: for complete groups of discrete points

– AO – Analog Output: for individual outputs requiring signal characterisation

– DO – Discrete Output: for individual outputs requiring signal characterisation

– MAO – Multiple Analog Output: for complete groups of analog points

– MDO – Multiple Discrete Output: for complete groups of discrete points

General procedure 1 In the fieldbus view, right click on the FBAP node of the Field Controller and select New 

Block, the New block dialog appears:

Fig. 5-1:  New Block dialog window

2 In the New Block dialog, select the Block Type you require, see also Table 4-1

– If necessary, enter a new Device Tag (otherwise the block will be numbered consecutively)

– Press OK to create the block

– The new block is added to the Field Controller

3 Repeat Steps 1 and 2until all the appropriate input and output function blocks have been 

created for the I/O modules in the rack.

4 Configure each block as described in the following sections.

5 When the control strategy is being created, see ControlCare Application Designer Overview, 

see BA017S/04/en or the appropriate tutorial, the configured block can be simply dragged and 

dropped from the fieldbus view into the strategy workspace and linked to the other blocks. No 

further configuration is necessary.
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5.3.3 Analog Input block

The Analog Input block is fully configurable and provides characterization for the incoming signal. 

The OUT value has the range and units configured in the OUT_SCALE parameter.

Fig. 5-2  Schematic diagram of Analog Input block

Procedure 1 In the fieldbus view, right click on the Analog Input block Device Tag-AI-n and select Off 

Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+Point)

– Click on End Edit 

4 Set L_TYPE to "Indirect" or "Indirect Sq Root" (for p flow analog input)

– Select L_TYPE, click the Edit button, select parameter , then click on End Edit

5 Expand XD_SCALE and set the parameters according to the signal from the input point. 

– EU_100 is the upper range limit of the input signal, e.g. 20

– EU_0 is the lower range limit of the input signal, e.g. 4

– UNIT_INDEX is the unit of the input signal, e.g. mA

– DECIMAL is the number of figures behind the decimal point

In each case click the Edit button, enter or select parameter , then click on End Edit 

For the SFC445 Temperature module, the ranges and units are listed overleaf.

6 Expand OUT_SCALE and set the parameters according to the signal to be output.

– EU_100 is the upper range limit of the output signal, e.g. 100

– EU_0 is the lower range limit of the output signal, e.g. 0

– UNIT_INDEX is the unit of the output signal, e.g. %

– DECIMAL is the number of figures behind the decimal point

In each case click the Edit button, enter or select parameter , then click on End Edit

7 For flow measurements a low-flow cut-off limit can be set as follows:

– Select the IO_OPTS parameter and click on Edit

– Select the Low Cut-Off option and click End Edit

– Select the CUT_OFF parameter, click on Edit, enter the limit in OUT_SCALE units

– Click on End Edit.

CHANNEL
(RRSGP)

SIMULATE

OUT

XD_SCALE OUT_SCALEXD_SCALE

FIELD_VAL(X)

SIMULATE

OUT_SCALE

LOW_CUT PV_FTIME

ALARMS

DIRECT

INDIRECT

IND_SQRT

L_TYPE IO_OPTS PV MANUAL

AUTO

From modules
SFC444
SFC445 
(via TEMP 
transducer block)
SFC457
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8 For a damped output use the PV_FTIME parameter

– Select the PV_FTIME parameter and click on Edit

– Enter the time constant (s) then click on End Edit.

9 If required, set alarm priorities and limits with the XX_PRI and XX_LIM parameters, see 

BA022S/04/en

10 Repeat the process for all inputs to AI blocks

SFC445 temperature 

ranges (XD_SCALE)
RTD 2-wire or 3-wire Differential

Type Range °C Range °F Range °C Range °F

Cu10 GE –20 to 250 –4 to 482 –270 to 270 –486 to 486

Ni 120 DIN –50 to 270 –58 to 518 –320 to 320 –576 to 576

Pt50 IEC –200 to 850 –328 to 1562 –1050 to 1050 –1890 to 1890

Pt100 IEC –200 to 850 –328 to 1562 –1050 to 1050 –1890 to 1890

Pt500 IEC –200 to 450 –328 to 842 –650 to 650 –1170 to 1170

Pt50 JIS –200 to 600 –328 to 1112 –800 to 800 –1440 to 1440

Pt100 JIS –200 to 600 –328 to 1112 –800 to 800 –1440 to 1440

Thermocouples 2-wire or 3-wire Differential

Type Range °C Range °F Range °C Range °F

B NBS +100 to 1800 +212 to 3272 –1700 to 1700 –3060 to 3060

E NBS –100 to 1000 –238 to 1832 –1100 to 1100 –1980 to 1980

J NBS –150 to 750 –238 to 1382 –900 to 900 –1620 to 1620

K NBS –200 to 1350 –328 to 2462 –1550 to 1550 –2790 to 2790

N NBS –100 to 1300 –148 to 2372 –1400 to 1400 –2520 to 2520

R NBS 0 to 1750 32 to 3182 –1750 to 1750 –3150 to 3150

S NBS 0 to 1750 32 to 3182 –1750 to 1750 –3150 to 3150

T NBS –200 to 400 –328 to 752 –600 to 600 –1080 to 1080

L DIN –200 to 900 –328 to 1652 –1100 to 1100 –1980 to 1980

U DIN –200 to 600 –328 to 1112 –800 to 800 –1440 to 1440

Electrical Single Differential

Unit Range Range*

mV –6 to +22 –29 to + 28

–10 to 100 –110 to 110

–50 to 500 –550 to 550

Ohms 0 to 100 –100 to 100

0 to 400 –400 to 400

0 to 2000 –2000 to 2000

*Each sensor must be designed for the single range
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5.3.4 Discrete Input block

The Discrete Input block is fully configurable and provides characterization for the incoming signal. 

The OUT_D value can be inverted setting the appropriate option in the IO_OPS parameter.

Fig. 5-3  Schematic diagram of Discrete Input block

Procedure 1 In the fieldbus view, right click on the Discrete Input block Device Tag-DI-n and select Off 

Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+Point)

– Click on End Edit 

4 If you want to invert the signal do it as follows:

– Select the IO_OPTS parameter and click on Edit

– Select the Invert option and click End Edit

5 For a delayed output use the PV_FTIME parameter

– Select the PV_FTIME parameter and click on Edit

– Enter the delay time (s) then click on End Edit.

6 If required, set an alarm priority and limit with the DISC_PRI and DISC_LIM parameters, see 

BA022S/04/en

7 Repeat the process for all inputs to DI blocks

OUT_D

CHANNEL
(RRGSP)

SIMULATE_D OPTIONAL
INVERT

FILTER
PV_FTIME

FIELD_VAL_D

PV_D

OUTPUT

ALARMS
DISC

MODE

From modules
SFC411
SFC415
SFC420
SFC432
SFC435
SFC438
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5.3.5 Pulse Input block

The Pulse Input Block provides analog output values based on a pulse (counter) transducer input. 

Two primary outputs are available:

•  OUT provides an analog rate based on the number of pulses counted per block execution. 

It is characterized by PULSE_VAL and TIME_UNITS and the engineering units are selected 

by scaling the output: the resulting range can be alarmed.

•  OUT_ACCUM is the accumulated number of pulses and is intended to be connected to an 

integrator block for differencing, conversion, and integration. It is used when the count rate is 

low relative to the block execution rate. The counter is reset by putting the block into MAN 

mode and entering a new value for OUT_ACCUM.

Fig. 5-4  Schematic diagram of Pulse Input block

Procedure 1 In the fieldbus view, right click on the Pulse Input block Device Tag-PUL-n and select 

Off Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 If you are using the OUT parameter, set the conversion parameters:

– Select PULSE_VAL, click Edit, enter the engineering quantity associated with one pulse,

the click End Edit

– Select TIME_UNITS, click Edit, select the units from the drop-down menu,

then click End Edit

– Expand OUT_SCALE and enter EU_100, EU_0, UNITS _INDEX (Engineering units)

and DECIMAL, clicking Edit to change and End Edit to accept parameters.

– For a damped output use the PV_FTIME parameter

– Select the PV_FTIME parameter and click on Edit

– Enter the delay time (s) then click on End Edit.

4 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+Point)

– Click on End Edit 

5 If required, set alarm priorities and limits with the XX_PRI and XX_LIM parameters, see 

Function Block Manual, BA022S/04/en

6 Repeat the process for all inputs to PULSE blocks

OUTCHANNEL
(RRSGP)
or
as per
device
manual

SIMULATE CONVERTION CONDITIONING

PV_FTIME
MAN

ALARM
PROCESSING

PULSE_VAL
TIME_UNITS

AUTO

OUT_ACCUM

MAN

AUTO

From modules
SFC441
SFC442
SFC467
or
FF device
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5.3.6 Multiple Analog Input block

The Multiple Analog Input block scales up to eight electrical input signals of 4 mA to 20 mA or 

1 V to 5 V to OUT_x values of 0% to 100%. The block can be used together with the SFC444 and 

SFC457 analog input modules. If other input signals are used with these modules, Analog Input 

blocks must be used.

Fig. 5-5  Schematic diagram of Multiple Analog Input block

Procedure 1 In the fieldbus view, right click on the Multiple Analog Input block Device Tag-MAI-n and 

select Off Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+9)

– Click on End Edit 

Properties The input channels of the SFC444 and SFC457 can be configured individually by jumpers on the 

printed circuit board to accept current or voltage signals, default setting current, see Chapter 3.5.1 

of operating instructions BA021S/04/en, Field Controller: Hardware Installation. The OUT value 

is proportional to the electrical signal over the range 0 mA to 40 mA and 0 V to 10 V. The MAI 

block converts the input as shown in Table 5-2.

Tab. 5-3:  OUT value as a function of input signal for SFC444 and SFC457 modules

OUT_1

OUT_2

OUT_3

OUT_4

OUT_5

OUT_6

OUT_7

OUT_8

MODE

CHANNEL
INPUT

SNAP OF
TRANSDUCER

BLOCK
OUTPUTS

From modules
SFC444
SFC457

I/O points 
AI 0 to AI 7
read together

RRSG9

MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO

Value Current Voltage

Input value OUT value OUT status Input value OUT value OUT status

Underrange limit 0 mA -25% GOOD 0 V -25% GOOD

Lower range limit 4 mA 0 % GOOD 1 V 0 % GOOD

Upper range limit 20 mA 100% GOOD 5 V 100% GOOD

Overrange limit 40 mA 225% GOOD 10 V 225% GOOD

Out of range >40 mA BAD BAD >10 V BAD BAD
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5.3.7 Multiple Discrete Input block

The Multiple Discrete Input block converts up to eight electrical input signals of low or high value 

into OUT_Dx values of 0 or 1. It can be used together with the SFC411, SFC415, SFC420, 

SFC432, SFC435 and SFC438 discrete input and discrete input/output modules. If signal 

characterization is required, Discrete Input blocks must be used.

Fig. 5-6  Schematic diagram of Multiple Discrete Input block

Procedure 1 In the fieldbus view, right click on the Multiple Discrete Input block Device Tag-MDI-n and 

select Off Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+9)

– Click on End Edit 

Properties The MDI block converts the input signals as into OUT_Dx = "0" or "1" as shown in Table 5-3.

Tab. 5-4:  OUT_Dx value as a function of input signal for discrete input modules

OUT_D1

OUT_D2

OUT_D3

OUT_D4

OUT_D5

OUT_D6

OUT_D7

OUT_D8

MODE

CHANNEL
INPUT

SNAP OF
TRANSDUCER

BLOCK
OUTPUTS

From modules
SFC411
SFC415
SFC420
SFC432
SFC435
SFC438

I/O points
DI 0 to DI 7
read together RRSG9

MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO
MANUAL

AUTO

OUT_Dx Value SFC411 SFC415 SFC420 SFC432, SFC435

SFC438

ON state level (True) 

OUT_Dx = 1

18 – 30 VDC 0 – 5 VDC, 

< 200 
Switch latched 15 - 30 VDC

OFF state level (False) 

OUT_Dx = 0

0 – 5 VDC 20 – 30 VDC, 

> 10 k
Switches unlatched 0 - 5 VDC
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5.3.8 Analog Output block

The Analog Output block is fully configurable and provides characterization for the outgoing signal. 

The OUT value is scaled with the PV_SCALE and XD_SCALE parameters.

Fig. 5-7  Schematic diagram of Analog Output block

Procedure 1 In the fieldbus view, right click on the Analog Output block Device Tag-AO-n and select Off 

Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select CAS from the drop-down menu if the block is part of an FF control loop

otherwise Select Auto, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+Slot)

– Click on End Edit 

4 Expand PV_SCALE and set the parameters according to the input signal.

– EU_100 is the upper range limit of the input signal, e.g. 100

– EU_0 is the lower range limit of the input signal, e.g. 0

– UNIT_INDEX is the unit of the input signal, e.g. %

– DECIMAL is the number of figures behind the decimal point for displays

In each case click the Edit button, enter or select parameter , then click on End Edit 

5 Expand XD_SCALE and set the parameters according to the signal output by the I/O module

– EU_100 is the upper range limit of the output signal, e.g. 20

– EU_0 is the lower range limit of the output signal, e.g. 4

– UNIT_INDEX is the unit of the output signal, e.g. mA

– DECIMAL is the number of figures behind the decimal point for displays

In each case click the Edit button, enter or select parameter , then click on End Edit

6 Repeat the process for all inputs to AO blocks

BKCAL_OUT

OUT
CAS_IN

SE

RCAS_IN

SP
FAILSAFE
ACTIVE

MANUAL

AUTO

CHANNEL
PV

SP

READ_BACK
IO_OPTS

OPERATOR
ENTRY

SP LIMITS

SIMULATE

FSAFE_VAL

XD_SCALE

PV_SCALE

XD_SCALE

PV_SCALE

SP
SELECTOR

(RRSGP)

To module
SFC446
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Properties The AO block uses the OUT values to force electrical signals as shown in Tables 4-4 to 4-6. The 

type of output is determined by the wiring (current or voltage) and DIP switch (Range end value 

5 DC or 10 VDC), see BA021S/04/en Chapter 3.5.1

• Current output

The parameters XD_SCALE_EU_100 and XD_SCALE_EU_0 set the range end values of the 

current signal output by the module. This is normally a standard 0 mA to 20 mA/4 mA to 20 mA 

signal, but other ranges within these limits are possible. The current output is independent of the 

setting of the Voltage Range DIP switch on the module and is directly proportional to the 

OUT value.

Tab. 5-5:  Current output of SFC446 module as a function of the XD_SCALE settings

• Voltage output (DIP switch OFF = range end 5V)

The parameters XD_SCALE_EU_100 and XD_SCALE_EU_0 set the range end values of the 

voltage signal output by the module. This is normally a standard 1V to 5 V/-5 V to +5 V signal, 

but other ranges within these limits are possible. The voltage output is dependent of the setting 

of the Voltage Range DIP switch on the module and is directly proportional to the OUT value.

Tab. 5-6:  Voltage output of SFC446 module with DIP swich OFF as a function of the XD_SCALE settings

• Voltage output (DIP switch ON = range end 10V)

The parameters XD_SCALE_EU_100 and XD_SCALE_EU_0 set the range end values of the 

voltage signal output by the module. This is normally a standard 2V to 10 V/-10 V to +10 V 

signal, but other ranges within these limits are possible. The voltage output is dependent of the 

setting of the Voltage Range DIP switch on the module and is directly proportional to the 

OUT value. The readback and OUT value reflect the XD_SCALE entries, not the voltage that can 

be measured at the output.

Tab. 5-7:  Voltage output of SFC446 module with DIP swich ON as a function of the XD_SCALE settings

XD_SCALE

Range 0 mA to 20 mA Range 4 mA to 20 mA

Value Output Value Output

EU_100 20 20 mA 20 20 mA

EU_0 0 0 mA 4 4 mA

Unit mA – mA –

XD_SCALE

Range 1 V to 5 V Range –5 V to +5 V

Value Output Value Output

EU_100 5 5 VDC 5 5 VDC

EU_0 1 1 VDC –5 –5 VDC

Unit V – V –

XD_SCALE

Range 2 V to 10 V Range –10V to +10V

Value Output Value Output

EU_100 5 10 VDC 5 10 VDC

EU_0 1 2 VDC –5 –10 VDC

Unit V – V –
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5.3.9 Discrete Output block

The Discrete Output block is fully configurable and provides characterization for the outgoing signal. 

Depending on the value of OUT_D the corresponding "True/1" or "False/0" signal is forced at the 

electrical output of the connected module relay output module SFC428, SFC432, SFC435 or 

SFC438.

Fig. 5-8  Schematic diagram of the Discrete Output block

Procedure 1 In the fieldbus view, right click on the Discrete Output block Device Tag-DO-n and select Off 

Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select CAS from the drop-down menu if the block is part of an FF control loop

otherwise Select Auto, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+Slot)

– Click on End Edit 

4 If you want to invert the signal do it as follows:

– Select the IO_OPTS parameter and click on Edit

– Select the Invert option and click End Edit

5 For a delayed output on recognition of a fault, use the FSTATE_TIME parameter

– Select the FSTATE_TIME parameter and click on Edit

– Enter the delay time (s) then click on End Edit.

6 Repeat the process for all inputs to DO blocks

Properties The DO block forces the output signals as shown in Table 5-7. NO (Normally open) and NC 

(normally closed) is the state of the relay when no power is applied to the module.

Tab. 5-8:  Relay status of the output module as a function of OUT_D

BKCAL_OUT_D

OUT_D
CAS_IN_D

 

SETPOINT

SP_D
CHANNEL
(RRSGP)SIMULATE_D

READBACK_D

MODE
SHED_OPT

OPTIONAL
INVERT

FSTATE_TIME
FSTATE_VAL_D

PV_D

OUTPUTOPTIONAL
INVERT

To module
SFC428
SFC432
SFC435
SFC438

OUT_D Signal NO Relay

SFC428, SFC432, SFC438

NC Relay

SFC435, SFC438

0 FALSE Open Closed

1 TRUE Closed Open
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5.3.10 Multiple Analog Output block

The Multipler Analog Output block forces up to eight electrical output signals between 0 mA and 

20 mA,–5 V and 5 V or –10 V to 10 V depending upon the wiring and DIP switch setting of the 

connected SFC446 module. The output current or voltage of Point x is directly proportional to the 

IN_x value, see Table 5-9.

Fig. 5-9  Schematic diagram of the Multiple Analog Output block

Procedure 1 In the fieldbus view, right click on the Multiple Analog Output block MAO-X Device Tag and 

select Off Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+9)

– Click on End Edit 

4 If you want to set fault values for the signal do it as follows:

– Open each parameter with Edit and click End Edit after the parameter has been set

– Select FSTATE_TIME and enter a delay between fault recognition and block reaction

– Select MO_OPS and check all inputs where a fault values will apply, 

check the appropriate inputs where this fault value is to be used on start-up

– Select the FAULT_VALX parameter of each input checked, and enter the fault value.

5 Repeat the process for all inputs to MAO blocks.

Properties The MAO block forces the output signals shown in Table 5-8. The type of output is determined by 

the wiring (current or voltage) and DIP switch (Range end value 5 VDC or 10 VDC)

Tab. 5-9:  Current and voltage output of SFC446 module as a function of configuration

 

IN_1

IN_5

IN_4

IN_7

IN_2

IN_6

IN_3

IN_8

CHANNEL

SELECTOR

RRSG9

FSAFE_VAL 1/8

FAILSAFE
ACTIVE

To module
SFC446

 
 IN_x

FSAFE_VAL_x

IN_x Current Voltage (DIP switch OFF) Voltage (DIP switch ON)

100 % 20 mA 5 VDC 10 VDC

0 % 4 mA 1 VDC 2 VDC

-25% 0 mA 0 VDC 0 VDC

-150% N/A –5 VDC –10 VDC
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5.3.11 Multiple Discrete Output block

The Multiple Discrete Output block forces the electrical outputs of the connected relay output 

module SFC428, SFC432, SFC435 or SFC438 to "True/1" or "False/0" according to the value of 

IN_Dx, which must be "0" or "1". If signal inversion is required, the Discrete Output block must be 

used. 

Fig. 5-10  Schematic diagram of Multiple Discrete Output block

Procedure 1 In the fieldbus view, right click on the Multiple Discrete Output block Device Tag-MDO-n 

and select Off Line Characterization. The Characterization dialog opens.

– Press the ALL button in the toolbar to display all parameters

2 Expand the MODE_BLK node and set the Target Mode to Auto

– Select the Target node then click the Edit button

– Select Auto from the drop-down menu, click End Edit to confirm the selection

– Click Close to leave the dialog.

3 Set CHANNEL to the input connected to the block as defiined in Section 5.3.1

– Select CHANNEL, then click the Edit button

– Enter the CHANNEL value (Rack+Slot+Group+9)

– Click on End Edit 

4 If you want to set fault values for the signal do it as follows:

– Open each parameter with Edit and click End Edit after the parameter has been set

– Select FSTATE_TIME and enter a delay between fault recognition and block reaction

– Select MO_OPS and check all inputs where a fault values will apply, 

check the appropriate inputs where this fault value is to be used on start-up

– Select the FAULT_VALDX parameter of each input checked, and enter the fault value.

5 Repeat the process for all MDO blocks.

Properties The MDO block forces all output signals as shown in Table 5-9. NO (Normally open) and NC 

(normally closed) is the state of the relay when no power is applied to the module.

Tab. 5-10:  Relay status of the output module as a function of OUT_D

To modules
SFC428
SFC432
SFC435
SFC438

 

IN_D1

IN_D5

IN_D4

IN_D7

IN_D2

IN_D6

IN_D3

IN_D8

CHANNEL

SELECTOR

RRSG9

FSAFE_VAL 1/8

FAILSAFE
ACTIVE

IN_Dx

FSAFE_VAL_Dx

OUT_D Signal NO Relay

SFC428, SFC432, SFC438

NC Relay

SFC435, SFC438

0 FALSE Open Closed

1 TRUE Closed Open
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5.4 Next steps

Once you have assigned all I/O module signals to the appropriate function blocks, you can now use 

them to create your control strategy. You must:

•  Create the complete control strategy

•  Assign the function blocks to the devices

•  Assign tags

•  Download the finished project to the Field Controller

These procedures are described in the following manuals:

Before the download can be made, you must connect the Field Controller to the subnet. This 

proceedure is described in the next chapter.

Component Description Document type Designation Order No.

Software Application Designer: FF Tutorial Operating manual BA019S/04/en 70101151

Application Designer: Local I/O Tutorial Operating manual BA032S/04/en 71095009

Application Designer: PROFIBUS Tutorial Operating manual BA036S/04/en 70701152

Application Designer: MODBUS Tutorial Operating manual BA037S/04/en 70701153

Application Designer: IEC 61131 Tutorial, 

Ladder Logic

Operating manual BA038S/04/en 70101386

Application Designer: IEC 61131 Tutorial, 

Structured Text*

Operating manual BA056S/04/en 71060063

Function blocks Function Block Manual Operating manual BA022S/04/en 56004886
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6 Going On-line

6.1 Connecting the Field Controller to the subnet

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

Note!

• The tools that setup the network use Ethernet services that may be blocked by Windows Firewall. 

Normally the firewall will be unblocked for the tools during installation, but it might be necessary 

to stop the firewall should they not function properly. If you are not sure how to stop the firewall, 

consult your system administrator.

In order to download the project, the host computer and Field Controllers must be allocated 

IP addresses in the same address range. It is possible to do this on the workbench before installation 

or after the Field Controller and other components have been physically installed in the Fieldbus 

network (subnet). 

Although Field Controllers support DHCP, for industrial systems we recommend the use of fixed 

IP addresses, see Chapter 6.1.1 and 6.1.2. Before starting, check the following:

•  Internet Protocol TCP/IP is installed on your computer

•  You have administration rights for your computer

•  You have an set of IP addresses that have been authorized by your IT department

•  Any proxy server for your Internet Browser is disabled

The procedures described in this chapter are for Windows XP. For other Windows systems consult 

your system administrator.

Note!

• SFC162 and SFC173 Field Controllers are configured in exactly the same way.

• When the Field Controllers are physically connected together with the Host computer via 

Ethernet, HSE Network Setup will see the them irrespective of the IP address domain to which 

they belong
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6.2 Network with fixed addresses

6.2.1 Setting the IP address of the host computer

The Field Controllers are delivered with the default IP addresses:

•  192.168.164.100 for Field Controller SFC162

•  192.168.164.101 for Field Controller SFC173.

In order that the host computer can communicate with the Field Controller Web Server, it must be 

allocated an IP address in the same address domain, e.g. 192.168.164.200. If you are not sure how 

to do this, consult your network administrator. 

Procedure 1 Right-click Start =>Settings =>Control Panel =>Network Connections

2 Right-click Local Area Connection => Properties

3 Using the left mouse button, double-click Internet Protocol (TCP/IP) or

click once, then click Properties. 

4 Note the original values of IP address and Subnet Mask of the computer to restore them if 

necessary at end of the operation. 
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5 Change the IP address and the Subnet Mask of the host computer to those required by the 

application. In the example, an address in the same subnet as the Field Controller. 

– IP Address 192.168.164.XXX and network mask (Subnet Mask) 255.255.255.0.

– Do not use the addresses 192.168.164.100 or 101,as these are reserved as default addresses 

for the Field Controllers SFC162 and SFC173 respectively

6 Click on the OK button to complete the procedure, close the other dialogs with OK and 

Close.

6.2.2 Setting the Field Controller IP address

Note!

• It is recommended that Field Controllers of the same type are introduced one by one to the 

network.

1 Call HSE Network Setup: 

Programs =>Endress+Hauser=>ControlCare=>Tools=>HSE Network Setup

2 HSE Network Setup is launched and searches for Field Controllers in the Ethernet network.

– All Field Controllers in the network appear, irrespective of their IP domain. 

If this is not the case:

– Check that the proxy server of your Internet Browser is switched off

– Check that the windows firewall is not blocking the program (switch off)

– Check all cables and switches

– If you find two or more Field Controllers with the same IP address, disconnect all but one 

from the network

3 If your computer has more than on NIC card, select the one you want to use for 

communication with the Field Controllers by ticking "Active NIC" and Press .
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4 Right-click on the Field Controller, the address of which is to be changed:

the Field Controller Web Server opens

– The Web Server will only open if the host computer and the Field Controller have 

IP addresses in the same IP domain.

5 Expand the Setup node and click Network

– Enter User Name "pcps" and Password "pcps" to open the Network Configuration dialog

– Enter the required IP address, in our example 10.125.35.180

– Enter a netmask, normally 255.255.255.0

– If required, enter a default gateway, usually address xxx.xxx.xxx.1 in the selected domain

6 Press Update to change the IP address

– You are now asked to restart the Field Controller

– Select the Restart node

– Select "No additional options" from the drop-down menu and press Restart

– Close the Web Browser

– The Field Controller disappears from HSE Network Setup and reappears with the new 

IP address
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7 Repeat Steps 4 to 6 for all other Field Controllers, introducing them one by one to the network. 

The result might be as shown:

8 If you are using the host computer, now set its address to the same domain as the Field 

Controllers, otherwise reset the original address.

– Restart HSE Network Setup

– Tick all Field Controllers that are to appear in the HSE Live List associated with the 

computer’s active NIC card.

– Press  to save the configuration.

– You are now ready to download the project
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6.3 Network with DHCP Server

Note!

• Although it is possible to use a DHCP assigned address with the Field Controller, we do not 

recommend its use in practice, as there is a risk that address may change on every power cycle.

A Dynamic Host Configuration Protocol Server (DHCP server) automatically registers the presence 

of the Field Controller in the subnet and allocates an IP address to it. This happens automatically 

when the Field Controller is switched on.

To use this method of addressing, your computer must have a DHCP server. In addition, the Field 

Controllers must be switched over to DHCP operation. 

Procedure 1 Change the address of the host computer to the default address range for the Field Controllers 

as described in Chapter 6.2.1

2 Check that all Field Controllers are disconnected from the network.

3 Connect a controller

4 Follow the procedure described in Chapter 6.2.2

– In the Network Configuration dialog, tick the DHCP box instead of entering an address

– Update the configuration and restart the Field Controller

– The Field Controller is automatically allocated an address

5 Repeat the Steps 2 to 4 for all other units in the subnet.

6 Change the host IP address to the one to be used in the industrial application

7 Start up the network anew, adding one Field Controller at a time to it.
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7 Trouble-Shooting

7.1 Simulation

All I/O function blocks running with the system can be set to simulation mode to check the function 

of the control strategies in which they are integrated. For blocks connected to the local I/O of the 

controller, simulation must first be enabled at the DIP switch on the rear of the Field Controller, 

which can be accessed with a small screwdriver blade.

To enable simulation set Switch 3 "SIMULATION" to "ON"

When all blocks and strategies have been checked, it is advisable to reset the SIMULATION switch 

to OFF.

Simulated values When the Field Controller is started, the status "SimulationActive" will be flagged in the 

BLOCK_ALM parameter SUB_CODE of the Field Controller Resource and I/O block as well as 

in the BLOCK_ERR parameter. Simulation is activated in the Input and Output blocks as follows:

1 Set the MODE_BLK to OOS, then set ENABLE/DISABLE to Active.

2 Set SIMULATE_VALUE and/or SIMULATE_STATUS by pressing Edit, modifying the value 

and confirming the change with End Edit.

3 Set the MODE_BLK to Auto, the the simulated values will be used by the block.

4 When simulation is complete, deactivate the simulation in the block and at the DIP-switch on 

the Field Controller.
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7.2 Factory initialisation and reset

Warning!

• Do not use the pushbuttons located in the Field Controller unless you are certain that you want 

to reset the system.

Note!

• The functions Reset, Factory Initialization and Hold can also be performed from the Restart node 

of the Field Controller Web Server, see Chapter 6.2.2, Step 6.

Fig. 7-1:  Position of the Init and RESET pushbuttons on the Field Controllers

Two pushbuttons located on the Field Controller, see Fig 6.1, allow the system to be initialised and 

reset. The function and effect of the buttons is described in the table below

• To "click " the pushbuttons use a pointed instrument (e.g. a ballpoint pen). 

• Any mode can be exited by keeping the right pushbutton pressed and releasing the left 

pushbutton.

• The rate at which the FORCE LED is flashing indicates the current mode..

Function Effect Procedure

Reset Resets system: the last 

configured IP Address 

is used

• Click the right pushbutton - the system resets (takes several seconds)

• If IP Address is found, a new one is assigned automatically

• Verify that the RUN and ETH LNK LEDs are lit.

Factory Init Deletes application, 

the last configured IP 

Address is retained

• Keeping the left pushbutton pressed, click the right pushbutton

• Check that the FORCE LED flashes once a second. 

• Release the left push button. The system resets, see above.

HOLD Stops all activities on 

the fieldbus

• With the RUN LED lit, keep the left pushbutton pressed and then double click 

the right pushbutton, checking that the FORCE LED flashes twice a 

second.Release the left pushbutton and the system will execute the RESET and 

then enter the HOLD mode. Verify that the HOLD and ETH LNK LEDs 

remain lit. With the Field Controller in this mode, you can use the FC Tools 

Wizard to update the firmware or change the IP address.

• Use the Reset again to return to the execution mode (RUN).

Default

IP Address

Sets default IP address • Keeping the left pushbutton pressed, click the right pushbutton 3 times

• The default IP address is set, see Chapter 6.1.2
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7.3 Updating the firmware

7.3.1 Downloading the firmware to the controller

You can check the firmware version of your Field Controller by opening the ENP node of its Web 

Server or viewing the FIRMWARE_REVISION parameter in the Online Characterization dialog.

Warning!

• Do not update the firmware of your Field Controller unless you have been expressly asked to do 

so by Endress+Hauser Service. Your ControlCare application is delivered with the firmware 

already installed in the Field Controller.

• New firmware is supplied with every update of Application Designer and is located in the folder 

Endress+Hauser => ControlCare => Tools => HSE.

Firmware update 1 Call FC Tools by clicking 

Programs =>Endress+Hauser=>ControlCare=>Tools=>FC Tools

2 FC Tools opens and searches for all Field Controllers on the network:

– Either double-click on the Field Controller row or select the row and press .

3 The Select a Firmware dialog appears: 

– If necessary, browse to folder in which firmware file is to be found

– Enter name of file: a double-click on the file located in look in fills this property

– Press Open to imports the selected configuration and start download

– The dialog closes and returns to FC Tools

4 The progress of the download is shown in the "Operation in progress" field

– When the download is successfully completed, the Firmware Version field changes
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7.3.2 Updating the firmware in the project

After a change in firmware in the controller, the project must be updated and download again using 

the Application Designer version corresponding to the firmware.

Project update 1 Open the project in Application Designer and select the bridge or gateway to be updated

– Right-click on the node and select Exchange...

2 The Exchange dialog for the bridge or gateway appears

– Open the Device Rev menu and select the highest revision

– Press OK to confirm the change and close the dialog.

3 The Incompatibilities dialog may now appear

– Press OK to automatically update all links

– Close the successful exchange dialog by pressing OK.

4 Press  to go on-line

– Right-click on the Plant node (very top of the project tree) and select Export Tags...

– Right-click on the HSE Network node and select Download

– In the Download dialog, press Start

– When the download is successfully completed close the dialog box.
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7.4 Trouble-shooting tables

7.4.1 Field Controller

Problem Remedy

1 HSE Network Setup/FC Tools does not find any 

Field Controller

• Disable the Windows firewall (normally a message 

appears ask whether you should unblock the program)

• Disable the proxy server for your Internet browser

• Check that you are using the correct Ethernet cables, 

see ETH LINK below

• Check that all Ethernet switches are powered up

• Check that the network adapter is on and OK: Execute a 

PING command to its own IP, via DOS PROMPT.

• Check if the Ethernet connection is OK: Execute a PING 

command to the Field Controller.

2 Field Controller appears intermittently in FC Tools Host and Field Controller are in different subnets.

• Normal behaviour, but for firmware download both host 

and Field Controller must be in the same subnet

3 HSE Network Setup/FC Tools does not show all the 

Field Controllers that are in the network

There is probably an IP address conflict in the network.

• Disconnect all the Field Controllers except one from the 

from the sub-network

• If necessary, change its IP address

• Now reconnect the other Field Controllers one after the 

other, if necessary changing their IP addresses

4 Field Controller Web Server does not open No Ethernet connection

• Disable the Windows firewall

• Disable the proxy server for your Internet browse

• Wrong subnet IP address

Host and Field Controller must be in same subnet

• Wrong subnet mask

Host and Field Controller must have same subnet mask

5 Firmware begins to execute but after a certain time it 

stops

It might be a configuration problem. 

• Use the Factory Init procedure and configure the Field 

Controller again. 

• If the problem persists, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

6 HOLD LED remains lit If the HOLD LED remains lit after the Field Controller has 

been turned on, the firmware may be invalid. 

• Update the firmware, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

7 ETH LNK LED does not light Check if the cable is connected correctly, or that the cable is 

not damaged. Check the specification of the cables:

• SFC954 - Cable Standard.  To be used in a network 

between the Field Controller and a Switch/Hub.

(preferred configuration)

• SFC955 - Crossed Cable (Cross).  To be used point to 

point between a PC and the Field Controller

(some PCs/laptops may have problems with crossed 

cable)

8 FRC LED is flashing (Force) Field Controller is powered up for the first time

• Battery is not switched on (see BA021S/04/en, p50)

Field Controller is in reset mode

• Complete the RESET procedure

Field Controller is in normal operation

• Battery is flat: 

– No problem if controller remains powered up

– If power is switched off, the project will be lost and 

must be downloaded again from Application Designer 

on repowering

9 ERR LED lit (SFC173) At least one slave is not delivering cyclic data

– Slave not connected to Profibus

– Slave not switched on

– Slave not correctly configured (PROFIBUS Configurator)
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7.4.2 Application Designer

Problem Remedy

1 Field Controller does not appear in HSE live list No connection to Field Controller

• See Remedies for Items 1, 2 and 4, Chapter 7.4.1

• Field Controller is on HOLD, set it to RUN mode

• IP address is not configured correctly, use PING to check

2 Field Controller appears but always stays grey in HSE 

Live List

No connection to Field Controller

• Check that host and Field Controller are in same subnet

3 Red cross appears on the Field Controller No communication with Field Controller

• No Ethernet connection with Field Controller, 

check connection, IP address etc, see above

• No Device ID set in the Field Controller (Attributes)

4 Red cross appears on Fieldbus/Profibus No communication with fieldbus/Profibus

• No communicaton with Field Controller, see above

• Fieldbus/Profibus not connected to controller

• DP bus parameter mismatch (Profibus)

5 Red cross appears on field device No communication with fieldbus device

• No communicaton with Field Controller, see above

• No communicaton with fieldbus/Profibus, see above

• No Device ID set (Attributes)

• Tag not assigned (Assign Tag)

• DP address is not unique (Profibus)

• DP address at device not the same as that configured in 

PROFIBUS configurator (Profibus)

6 A device does not appear in the live list Communication error

• The device is not powered up

• The project has been updated but no download has been 

made yet

7 Configuration will not download You have either a communication problem or the 

configuration is not complete

• Check that you are on-line - press the On-line button

• Check that your computer is in the same address subnet

• Check that you have assigned the Field Controller tag

• Check that you have exported all tags OPC server

• Check that the parameters are in the recommended order

• Check that the OPC server is running (look for icon in 

bottom line)

• Try "Update" from the Field Controller node (SFC162 

only, takes several minutes) and download again

8 PROFIBUS configuration will not download You have either a communication problem or the 

configuration is not complete

• Try downloading from HSE Network node, see above, if 

this does not work, check points below

• Configuration mismatch between PROFIBUS Configurator 

and Application Designer

– Have PROFIBUS device blocks been deleted?

– If so, reconfigure project in PROFIBUS Configurator

9 Parameter appears red in the on-line control strategy The parameter has a bad status

• Check that the Block Mode is Auto (or Cas)

• Check that the block has been correctly configured

• Check that the device is still live (live list)

• Check that the device address is the same as that you 

have in your configuration (live list)

• Check that the parameter has been correctly configured

• Check that the tags were exported (Export Tags)

10 FB links do not work Project not downloaded correctly, e.g. partial download 

when bridge has HSE links

• Repeat full download from the HSE Network node
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7.4.3 PROFIBUS Configurator

Problem Remedy

1 Error message on trying to leave the configuration 

dialog

Configuration not correct

• Device name has spaces instead of underscores

2 How are the cyclic I/O data configured? • For Endress+Hauser devices each parameter has a fixed 

position in the configuration list, see the manuals. If you 

want to see Parameters 1 and 5 only, for example, free 

spaces/empty modules must be appended at slots 2, 3 and 

4.

• For other devices, see operators instructions

3 What baudrates are supported? The SFC173 Field Controller supports all baudrates with the 

exception of 31.25 kBit

4 What baudrate should I use? Only baudrates supported by all devices can be used:

• For a P+F SK1 coupler = 93.75kbit/s

• For a Siemens coupler = 45.45 kbit/s

• For a P+F or Siemens link, check what baudrates are 

supported by all DP devices

5 Where do I set the device baudrates? Only PROFIBUS DP devices must be set

• Most PROFIBUS DP slaves sense the baudrate and do not 

need to be set up

• For others, check the manufacturer’s instructions

6 What bus parameters should I use? Use the parameters recommended by the coupler/link 

manufacturer or those in this manual

• For the P+F SK2, the parameters are automatically set 

according to the rate selected in the Configurator

• For the P+F SK1 use the ones in the PROFIBUS tutorial

BA036S/04/en

7 Can I go on-line in PROFIBUS Configurator? Yes. 

• Select the appropriate menu, enter the IP address of the 

Field Controller and generate a live list

Beware of timeout: if there is no activity after 2 min:

– Select Settings => Device Assignment...

– Driver Select (if TCP/IP driver)

– Select requested IP address

– Press OK

8 Can I change a bus address in the PROFIBUS 

configurator?

Yes. 

• You can go online and change a bus address by selecting 

the device followed by the the appropriate menu and 

typing in the old, then the new address

• The device must support software address setting

• Software address setting must be enabled

• The address must be unique to the bus

9 A device does not appear in the live list Communication error

• Another device has the same address

• The device is not powered up

• Device does not support autosense of baudrate 

– Set correct baudrate
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For your notes
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